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UNIT NAME:              Business Information Technology and Systems

UNIT CODE:              CSE1720 

APPLICABILITY:        Elective

PREREQUISITES:     Nil

TIME ALLOCATION:  52 hours

TEACHING METHOD:  A two-and-a-half hour lecture, one 90 minute tutorial and                                           one 90 minute self study period, for 10 days.                              

AIM:                           To introduce the terminology of Computing and to the use 

                                   of Computing Technology (Hardware and Software) in the                                            

                                   (mainly) Business  environment.

OBJECTIVES:            Students who complete the unit should:-

                                    . have an appreciation of the nature, role, technology and                                                 

                                      functions of various types of hardware and  software   

                                      which  form  a computer system

                                    . be able to understand the functions of operating systems                                          

                                      and be able to use Windows Operating System and 

                                      management support software such as spreadsheets, 

                                      database and word processing

. be able to explore software based on a Windows            

  interface

ASSESSMENT:         Final Examination                     50%

                                   Assignments




  Text Retrieval                            15%

                                   Spreadsheet                             15%

 
                        Database                                   20%                Total 50%

Students must achieve at least 40% of the marks in either component in this unit and must gain an overall 50% of the total marks to obtain a  unit pass. The final mark will be the lower of the 2 components marks plus 10

REQUIRED TEXTS     Parker, Charles S and Morley, D   Understanding                                                       

                                    Computers Today and Tomorrow - 2002 Edition.    Dryden                                        

                                     Press 

                                     Monash University CSE1720 Notes and Exercises ,                                                  

                                     Summer Semester 2005 

REFERENCES          


                          H.L.Capron Computers. Tools for an Information Age


                Fifth Edition.  Benjamin Cummings




     Turban,Rainer and Potter. Introduction to Information                                                

                                      Technology. John Wiley and Sons Ed 1 (or 2, if available)

                                      Computer Concepts  5th Edition.  Parsons and Oja

                                      Thomson Learning




      Technology of Internet Business.  Lawrence, Newton,                                                

                                       Braithwaite and Parker. John Wiley and Sons

OTHER REQUIREMENTS   4 No. 3.5 in(90mm) diskettes High Density 

                                          or 4 CDW-Roms

The unit materials are available on the Web at

 http://www.csse.monash.edu.au/courseware/cse1720s 

My phone number is 99032352   

My email address is  rod.simpson@csse.monash.edu.au

Unit Outline  CSE1720,    2005

Summer Semester  (Semester 3, Summer C)

  Day   Session No.     Concepts                                      Software    

 Mon 22/11       Overview of unit 
                              Directories,Files

                         Computing System Applications        File specifications

             1          System Components 

        Storage/Retrieval                                                      

                         Classifications of  Computers            PC/Windows                                                       

                         Speed terms, chips, history  
        and functions



   The Information Age

Tue   23/11     Corporate Structures,Reports
         File Management 

                                                                                                 functions

                        Hardware terminology 

          Erase, clear, make and 


   A computer  system 

          remove directory  and

             2         Input devices   


          folders. Format, 

                        Storage devices 
 
 
          Scandisk. Use of

                        Typical Configurations

          sub-directories.

                        Spreadsheets - main characteristics     Directory tree structure. 

Wed  24/11     Software - Systems, Application           Main Menus, Sub Menus

                       Operating Systems

                    Saving, Retrieving


3           Spreadsheets - Design and
          On-line help




  Extended functions

Thur  25/11      Windows O/S features

           Cell formulae



   Registry.  Chips. Buses
 

Built In functions

 

   Input / Output devices


 4
   Source Data Automation



   Storage Devices and Access mechanisms



   Ethics

  Mon   29/11   Range of Business Information

Retrieval needs



  System Solutions



Backup / Recovery


5
  System Development Life Cycle


 

       

  Project Management

   Tue    30/11  The World Wide Web and Internet
Documentation



   E-commerce                                         Access Database functions

          6            Processing modes : Batch             
Windows, Dialog Boxes

                        On-line. Off-line storage

           Pull down menus

            Session No.                 Concepts                                      Software

     Wed   1/12 
    Relational Database
                       Query 

                                                                                                  language functions 

                                    Benefits, Disadvantages of database
 SQL (Oracle)


      7
              Information Retrieval Systems

  MS-Access   

     Thur   2/12              Communications             

  Data Definition


       8    





             Access Report

and Label        

Generator

      Mon   6/12  
Metrics,                                                        Microsoft Word

                                Measurement and Management       

                   9           Of Performance                      

      Tue  7/12          Review of software

                10           Project Management       

       Wed 8/12         Emerging Technology   

                  11         Course Revision and Questions

       Thur  9/12          No lectures on this Thursday

        Friday  10/12              Examination                          9.30am -11.45am 



                  To be held in   (rooms to be  allocated)         

SYLLABUS



1. Introduction

                      1.1  Computer applications in  the commercial environment

                      1.2  Components of a computer  system

                      1.3  Typical components of micro, mini and mainframe systems

                      1.4  Hardware and Software  

       Classes of computers

                            Information Technology and its Links with Business

                      2. Data Storage and Retrieval

                      2.1  Data types

2.2 Storage of data - Database, Text, Structured Data, 

Non-Structured Data

                      2.3   File structures

2.3 Internal and external storage - Memory, cache, magnetic and                                                                                    

                            optical

                           Technology developments -  Types of Chips, Operating      

                           Systems Windows2000/XP  -   Registry, Components, Controls

                      3. External Storage 

                      3.1  Mass storage devices

                      3.2  Updating data

                      3.3  Data representation

                      3.4  Distributed data storage

                      4. Input/Output devices

                      4.1  An overview of the types of devices currently available

                  with emphasis on the device applications. (Automated Teller               

                   Machine System)

                       5. Data Communications

                       5.1 Computing and Communications

                       5.2  An overview of communication concepts

                       5.3  Communications hardware and software, and application

                       6. Security, Integrity and Privacy

                          6.1  The importance of these aspects

                       6.2  Techniques to obtain security, accuracy and privacy

                       6.3  Some legislation

                       7. Business Applications 

                          Applications of computing in the business environment  

                          The Internet and e-commerce

                           Portals

                      8.  Communications



8.1 Networks

                
8.2 Distributed processing and Databases


             
9. Metrics



9.2  Measurement and Management of Performance

  

10. Project Management  

            
10.1 Growth and Applications

            
10.2 Purpose / Benefits

                              Applications

           
11. Data Management (structured and non-structured)

         

11.1 Data base  

          

11.2 Data storage and access

          

11.3 Data base management systems - Access, Oracle

         

11.4 Data base administration

          

11.5 Public data bases



11.6 Data Mining



12.    Decision Support Systems 

          

12.1  Decision Support Models


           12.2  Intelligence in Business Systems

Microsoft Operating System Notes


*** MICROCOMPUTER OPERATING SYSTEMS ***

1. PURPOSE

The main purposes of any operating system are to manage the resources (CPU, Memory, peripherals) and to provide an interface with the user (and the user         application programs)

In this unit you do not need to know HOW they work, but you will need to use the   language interface so that your computer will operate accurately and as you         require.

2. MICRO OPERATING SYSTEMS

The major operating system 'families' on the I.B.M. (and compatibles) are:  

 Windows (95, 98, NT), 2000 and XP

You will also find references to IBM’s OS/2 which is an operating system aimed at the high end  of the 'micro' computing range of equipment in competition with Microsoft.

There are other operating PC systems in use but the above are the most common. You should appreciate that special purpose operating systems can be written by skilled programmers.

Operating systems are 'versionised', that is there will be a number of versions         available. In the case of NT, these versions are known as Version 1.nn, 2.nn, 3.nn, 4.nn and 5.nn.  There are also 'fixes' to Windows95/98/NT. (service packs)

As with most software, 'older' version application programs will probably run on the latest operating system version, but latest versions of application programs will run with difficulty, if at all, on older versions of operating systems. 

Windows 95, NT, 98, 2000  and XP are  complete operating systems. Windows XP is available in the Computer Centre laboratories. 

Operating systems for mini and mainframe computers include Unix, VMS, MVS,      Xenix, OSF, Ultrix, Linux.  Some of the Caulfield labs. support Linux, others        support Unix.

How Personal Computer Operating Systems are Supplied to an authorised user:

As with the majority of software, PC Operating Systems are supplied on a transferable medium (Diskettes or CD-ROMs). The software must then be loaded into the appropriate microcomputer. When you purchase a microcomputer, make sure that in addition to the hardware you also obtain a legal copy of the version of Operating System for your purposes, and that you also obtain an Operating         System manual. In fact you should obtain a manual for ANY software which you purchase. You should also create the Startup disk. (see more on Page 17).

Software can also be downloaded from a 'server' computer. There are some moves to provide all services from such a ‘server’ concept.

FOLDERS (called Directories in other than Microsoft Operating Systems)

         A Tree Structured system is the most common organisation.

 FILE NAMES

        Any managed file can be expressed as 

            (i) a file name of up to an allowable number of characters

                  (8 in the case of Windows 3.11, (no spaces are allowed)

                16 for Windows95)            

            (ii) an extension of up to 3 characters

            (iii) a . between the filename and extension if this is used.

        monday.bat, cse172, 345.wks, exercise1.pic are acceptable forms of                        filenames. Wondering.prn, exercise12.xls,  apple6pie.new are acceptable to           Windows9x, 2000, NT and XP.

FILENAME EXTENSIONS,  SYSTEM PROVIDED

There are a number of system filenames which you will notice. Files ending in .EXE, .COM, .SYS, .WKn, .DBF, .XLS, .MDB are all system recognised extensions. You will be using   .XLS, .PPT, .DOC and .MDB extensions in this unit.

DISKETTE FEATURES AND HANDLING

There are a few points about diskettes which you will find helpful and which, if followed, will avoid the 'all my data/work is lost' syndrome. This syndrome regularly appears either immediately prior to or on the day an assignment is due to be handed in. (It applies to assignments on disk and hard-copy )

1. Be careful of your disks and RW CD Roms. Don't touch any exposed surface, don't bend them,  don't write labels on them and don't expose them to high or low temperatures. A refrigerator is NOT a recommended safe storage area, nor is a      drying cabinet.

2. Use the WRITE-PROTECT feature when possible. 

3. Label your disks internally (the Format and Label commands will do this -(the      entry point  is My Computer) and externally (stick-on tags) 


 4. Use software to examine your disk/CD Roms for Virus infections.  Never copy from another diskette without ensuring that the source and the target are virus- free.

 DO NOT copy from a diskette to your hard disk unless you have checked the diskette is virus free.

 5. Don't leave your disks/CD Roms lying about. They might decide to walk off     and you may never recover them. If you do lose computer items, including your password, try at the Help Desk at Merlins, or the Student Union Office. The help desk in K Block may be a good source.

 6. Always have a copy of your work on a SEPARATE diskette.

INTERNAL AND EXTERNAL COMMANDS

INTERNAL commands are those that are used frequently by the user and thus the Operating System. They are normally held in memory to provide very fast access    and execution. You should be able to associate these with the Windows functions  after the first tutorial.

EXTERNAL commands are those which are not used as frequently and include      FORMAT, DISKCOPY, TREE, XCOPY, DISKCOMP.  They are held on external     storage (diskette or hard disk) and are called into memory when required.

        -- and the difference ?   --->  Processing throughput

KEYBOARD, SCREEN ICONS, MOUSE AND SPECIAL KEYS

One of the aspects of using a microcomputer is that you, the user, are also the       controller and are responsible for all keyboard functions. This means that you will    need to acquire dexterity in using a keyboard and a mouse. Don't assume that this is just for this unit. Computing has made such inroads into the business             environment that you will need this skill for the rest of your working lives - AND you will need to continually update your skills.

At the start then, and although you may find this frustrating, take a good look at the keyboard. Notice firstly the presence of    (i) alphabetic keys

              



          (ii) numeric keys

             



         (iii) function keys

             



         (iv) special keys

Then notice how they are grouped. Also notice that not all keyboards are the same.

Notice the types of special keys :

           TAB                 
 CAPS LOCK        
SHIFT

           CTRL               
 ALT                
ENTER               

           The up,down and sideways  ARROW KEYS           


BACKSPACE 
 INSERT          
 HOME                           

           END                
 NUM LOCK        
 ESCAPE

           The function keys F1 to F12

           Notice the location of special characters

           ! ~ @ # $ % ^ * ( ) _ - = + , / \

During this unit you will use all of these keys, and the sooner you are able to use the keyboard with a degree of skill and speed, the more you will be able to concentrate on using the power of the computer, not spending your time looking for the appropriate key or keys.

And how do you acquire this skill?  One way is to attend a course on keyboarding. The university runs these courses at the three campuses. Course(s) run for 20 hours and provide a very good introduction to Personal Computers. You can also spend time in practising and developing your skills. Courses are also run for Windows based products. Details are available from the Computer Centre, F Block, level 5 and at the Help desk – try Merlin’s Coffee Shop.

ENTERING COMMANDS

You will not be able to use any computer unless you know which commands it will respond to, what program names are required to run certain jobs, what password procedures are applicable, and how to load, unload, recover and so on. This isn't easy, but you are in fact learning how to live with new technology, and with technology which is expanding and developing.

You will also need to become conversant with 'system messages', that is, to understand what the system is trying to tell you. 

There are a few terms which you will need to know: 

(i) system prompt.  This indicates that the system is waiting for you to enter something. The system prompt message will look like K:\ or L:>, or if you have your own machine possibly C:\ or C:>              With Windows, and a mouse, it is normally the presence of the broad arrow.

(ii) the 'drive' designator. Microcomputers can have from 1 up to 26 drives. These drive codes 'tell' the system which physical unit is the current unit from which, or to which, data can be retrieved or stored. In other words they are the codes to the disk drives. As computers are developed, other devices will be attachable, and these also will have a unit code.


Drive codes look like A: (Called A drive) - a replaceable disk drive

                                              B: (Called B drive) - a replaceable disk drive  

        


             C: Is normally the fixed disk unit (hard disk drive)




             D: Is frequently used as the CD-Rom drive

     



 U: Is your own allocated disk space

COMMAND STRUCTURE

A command will require

1. A command code (always)

2. A source (sometimes)

3. A target (sometimes)

There are many command types which have extensions. 

Windows Explorer will provide much data on folders and files. It's worth trying it       out.

Explorer will also provide means of connecting to the drives available (a:  b:  c:        etc) and will provide access to sub-folders (or sub-directories).

When using Windows, you will need to be able to recognise the icons and menu terms which will provide you with the process you require.

The exercise in the first tutorial will introduce you to some of the commands and icons which you will use regularly. 

Finally, to initiate action, you must use the Enter key or click the mouse key. 

As a general rule, to start a process use the Enter key. If you wish to back out of an entry or partial entry, use the Esc (escape) key.

When using Windows, you will need to click the mouse button - once or twice, left or right, depending on the function. 

POWERING ON AND OFF

Look for an On/Off key, usually on the processor. If the screen doesn't come on, look for an additional switch on the device .

WARNING:  DO NOT HAVE A DISKETTE IN DRIVE A or B WHEN POWERING ON.

REBOOTING.  If the computer hangs, i.e. won't respond to your keyboard entries, it will need to be rebooted. If it has a 'reset' button, use this. If it does not have this facility, use Alt+Ctrl+Delete keys simultaneously and watch the screen prompts. Alternatively, power OFF then ON

If you have to use either of these operations, you will have lost anything which you had previously developed in the memory.

Again, do not have a diskette in A: or B: when rebooting or restarting.

LOGGING OUT 

Different techniques will be necessary depending which software you have been using.  Again, this is part of becoming computer literate, which is one of the many skills which you will acquire during this course.

When quitting a session from the network units at Monash, you will be required to use the command LOGOUT.

This will terminate your session with the network, and has the added advantage of preserving your time quota. When using software packages such as  Windows, Access, Word, Excel (etc) :

    You MUST logout of the current package,  then logout of the  system.

                 
Tutorial and Laboratory Work in this Unit

The practical work is directed to spreadsheet development and use, the       development of a small database using a DBMS (and also using some of the associated functions), database text retrieval using the Library CD-ROM system, and a brief excursion into the World Wide Web, Microsoft Word and Powerpoint.

There will be a Voyager, Resource database and an Internet data retrieval Library  assignment,  a spreadsheet  assignment, and a database assignment. 

At the end of each chapter in the recommended text (Parker and Morley) there is a number of questions either of the matching, true/false, multiple choice or short     answer type. You are encouraged to study these and they will prove to be a          valuable source for revision of the unit.

There are some development exercises in these notes to provide you with some of the features of spreadsheet processing and database development. Remember that spreadsheet software contains a very comprehensive set of functions and that in this course you are being introduced to only some of them.

You will be expected to read both the work referred to in the recommended text book as well as doing the development exercises. You will need to allocate additional time for this work and may need to use laboratories, other than that booked, when they are available.

As a rough guide, you will need to spend about 6 to 8 hours a week in the Summer Semester of your own time.

Commencing Laboratory Work

You are now going to commence Laboratory work. 

You must be a registered user. You should have received details from the University regarding you account code and password, including Authcate.  If you are having problems,  you should contact the Student Services , Level 1, A Block

The enrol procedures set up a password for you  (and your Portal) - please REMEMBER IT!

If you forget it, or you suspect that you need a new one, go to Student Services, Level 1, Building A.

TUTORIAL WORK  -   SESSION  1

READING:  - Parker and Morley : Pages  INT 1- 27           

Windows is claimed to be a highly intuitive tool requiring only minimal explanation.  In this session you will navigate around some of the Windows functions using the  mouse. Generally, processes are made active by clicking         

the left hand mouse button once or twice, depending on the function.

Your laboratory computer in the Caulfield laboratories will be operating under           Windows XP   

TUTORIAL WORK  (Hands On)        -   SESSION  1

Perform these operations

Start your terminal and follow the prompts. Connection takes a few minutes. When the icons appear and are steady, you can proceed to use the terminal.

 At the system prompt, load one of your new diskettes into A: and proceed to      format it.  Click on the icon ‘My Computer’, then click on the Diskette A;\   then on File, and select the Format option.   Follow the prompts and start the  process. 

 3. When prompted for the label name, use your student I/D or your name.

 4. Format any other NEW diskettes you have, and any others which contain 

unwanted data.  Close the process, and escape from the process by clicking on      the X in the top right hand corner of the panel.     

 5. Point the mouse at Start, (bottom of screen) and slide it up until you locate              ‘programs’. Move the mouse sideways and then down until you locate Windows       Explorer. 

     Inspect to see if there are any networks drives available, and if there are,                attempt to copy the contents of one of them to your diskette – make sure that         they are not large ( > 800,000 bytes)  files. Connect to U:  Is there any content ?         

6. Use the View submenu and investigate the use of its options.  

7. Make a folder (very similar to a sub-directory) NEWONE on A:   Use the                  Windows Explorer  File, New, Folder  options.  Key in your preferred name to          name the folder.                   

8. Inspect your disk contents again .

    Notice the new entry ?     Notice the way the folder is shown ? 

9. Click on this new folder.          How many files are present ?

10. Highlight some of the files in the root folder (hold the Ctrl key down for                     more than one file) and copy and paste these to your new folder. Check that           the files actually exist in your new folder.   Cut and Paste these files also, then       check the entries in the source. If they have gone, where are they ?

Exit from Windows Explorer.  Click on the X in the top right hand corner or File, Exit 

The screen should now present a number of 'Groups' with an icon and text label indicating what the icon refers to.

Click on Start and glide the mouse to Programs. Move the mouse sideways to Accessories. Locate the entry ‘ Command Prompt’ and click on it. Exit from the Command Prompt and re-engage Accessories. 

Locate the ‘System Information’ sub menu, and find out details of the device you are using. How much main memory does it have ? What capacity hard disk ?

Make the ‘My Computer’ icon active and explore its functions and options.  The right  button on the mouse should be used to do this.

Point to one of the icons, hold the button down and 'drag' the icon to another  location.        

Point to the time on the task bar (bottom of screen) and you should get an        analogue clock with a reference to the time setting, and also the date. Alter it if       necessary.

Activate ‘My Computer’ and from the panel of available drives, select C: and            inspect the entries. Scan the Folder names and Folder  contents

Change to another drive and repeat the process. Select a Folder and inspect its     content names - files and sub-folders. 

Move the mouse across the entries in the My Computer Title Bar and inspect          the drop down entries in each menu.

Try the Help function and search for help on Format and Delete. Exit from Help.

Using the prompts, try to delete a file from your diskette. Watch carefully. Then go to the Recycle Bin and make sure the file is there. How would you delete it from the Recycle Bin ?    What is the purpose of the Recycle Bin ?

This exercise will provide you with details about your PC hardware specifications

Once you have logged into the system


click on Start, Settings, Control Panel and then the System icon.


This will display for you the available memory and the Operating System.

Click on the Devices tab and all of the connected hardware will be displayed.

To see the hard disk size, open Explorer (if it isn’t already open), right click on Drive C (C:) and select Properties

This will show how much of the disk is used, and how much is free.

See if you can locate the Microsoft office software, and load one of the modules such as Microsoft Word. 

On the bottom bar , locate the current  Antivirus Software icon.  Click on it and find out what it is, what version it is, and if it is active or not.

Finally exit from Windows XP and then from the system. You should repeat this exercise at your next tutorial session or whenever you can.  Use the Computer   Centre terminals (or even better, your own computer with Windows 98, 2000  or      XP).

Revision :   Parker and Morley     INT28  Questions 1 to 32

Every computer owner should have a Windows Startup floppy disk which should be the same version as that installed on the hard disk.  If/when your hard disk fails, (and you will probably see a message like ‘Operating System not found’), boot off this floppy, and try the command dir c:. If this succeeds, type fdisk/mbr which will repair the Master Boot  Record and then type sys c: which will transfer the operating system to the hard disk. Run scandisk on the hard disk when the system has booted.  If no directory listing of the hard disk can be obtained, then you have lost all of your data. – but you have made backup copies haven’t you ?  You will need to re-install Windows and your data to become operational again.

TUTORIAL WORK    -    SESSION  2

READING: Parker and Morley : Pages 93 to 112. Also Excel 266 to 272


      Revision: 
Page 122 to 124

There are a number of additional exercises relating to Windows95 / NT /2000/XP, Excel and Access at the end of these notes. It is strongly suggested that you work your way through them.

SELF DEVELOPMENT :

Click on Programs, Settings and browse through the icons displayed. Don’t change anything unless you are sure of what you are doing. The icons in the Laboratory devices are controlled centrally.

When you have finished this, load Excel and follow the exercises on page 35 of   these notes. There are a number of them, and you should work you way through them. 

Take your time and be confident that you can perform the functions.

Select the drive for retaining any output and use this diskette again at the next tutorial.

You should do a preview and make sure that if there is something there which you cannot answer, raise it at the beginning of the next tutorial.  If you can't answer it, there are probably others with the same problem.

Further Support : Parker and Morley   Pages 266   to 272

You should start the preliminary design of your First assignment

Use the Help Staff in the Library if you have problems. They are very keen to make sure that you can use Library facilities correctly and efficiently – and of course, it’s in your own interests to be able to use this resource confidently and competently.

TUTORIAL WORK    -    SESSION  3

READING:   Parker and Morley : Operating System Software  Pages 211 to 224

Revision :     Pages 242 – 243.      Questions  Pages 244 to 246

SELF DEVELOPMENT:

This session you will commence to build a spreadsheet using Excel, and the best way to do this is to follow the procedures outlined on Pages  35 and 36 of these notes.

The tips are quite helpful and should be used.

Altering the size of columns and entering of formulae is also covered in the examples, and although the examples are simple, they are a good guide to the functions you will need in your assignment.

FORMATTING: Follow the instructions and samples on Pages 35 and 36.

CLOSING, SAVING AND OPENING A WORKSHEET: Always tag your worksheet with the ‘Always Save With Backup’ option. You will find that this will greatly reduce stress levels when you have corrupted the current sheet. (notice the ‘when’, not ‘if’’.)

Parker and Morley  pages 268 to 271 also have good material on worksheets. 

Continue with the development of your assignment         

TUTORIAL  WORK   -   SESSION  4

 Revision  : Parker and Morley   :  Pages 223 to 224 and 149 to 153

                                                      Questions Pages 159 – 161 

SELF DEVELOPMENT:  The Excel development exercises in these notes will give you a basis of understanding of Excel and its many functions. There is not enough time in this unit to cover all of these functions.

The exercises take you through the construction of a larger worksheet and then onto copying and moving of formulae and to the use of Excel functions - SUM, AVERAGE, MAX, MIN ....

Any difficulties you have should be raised at the next session with your tutor.

If you are confident that you can perform all of the functions so far, you should read through Exercise 3, to become familiar with ways in which spreadsheets can be enhanced.

Items covered are:
                      Insertion of blank cells






Clearing cells






Centering Titles






Changing Row heights






Custom =SUM  formulae






Absolute addresses






Changing Font Styles            

Your assignment should also be completed by this Session, and you have       Assignment 2 available for preliminary reading.

TUTORIAL WORK  -  SESSION 5

READING: Parker and Morley : Pages 495 to 507

SUGGESTED EXERCISES and QUESTIONS: Pages 509 - 511

SELF DEVELOPMENT :

There is an interesting exercise which introduces you to Random number             generation and the development of a scatter chart and a line chart on Pages 38      onwards of these notes. It will help you with your Excel worksheet assignment.

TUTORIAL  WORK   -   SESSION  6


E-Commerce and the Internet

READING: Parker and Morley  :  Pages 440 to 466

Revision :   Questions Pages 466 to 469

SELF DEVELOPMENT : Complete the exercises in Excel in these notes.




You should be able to complete the spreadsheet exercises on Pages  35 to 41 of these notes.

There is an exercise on Pages 40 and 41 which relates to data accuracy and existence. You should read this and do the short exercise.

.

TUTORIAL  WORK   -   SESSION 7

An Introduction to Database

READING: Parker and Morley: Pages 565 to 591





     Questions pages 595 - 598  
       

It is doubtful if the full realisation and utilisation of what we generally call The          Internet has been , or could be, adequately understood.

This chapter introduces some of the wide ranging aspects of the use of this facility and of course to the data which is 'at the end of the line' of a connection.

Chapter 8 delves into some of the aspects of Privacy, Security  and Ethics, and while it is easy to dismiss these as 'not being important in computing', you will find that they are extremely so.

If necessary, laboratory work today will be aimed at completion of the Spreadsheet assignment.

TUTORIAL  WORK   -   SESSION 8

Database Management Systems

You should have a copy of the Database Assignment at this session.

We are now moving from Worksheet/Spreadsheet Software, which gave you the ability to manipulate mostly numeric data in a matrix form, to another Microsoft package which will allow you to manage data in structured record form.

The facilities in Microsoft Access allow you to generate, update, modify, delete, and append records in an environment which is controlled by database              management software.

You will find some similarities to some of the worksheet functions but there are also some different techniques and requirements.

You will notice some changes in the presentation of the functions. This is caused by the different authors of the software packages and by the efforts to make the package "user friendly".

Today's laboratory work will be directed at Microsoft Access and some of its functions, such as creating a small database and embedding some Integrity constraints, then applying some (5 to 10) rows of representative data.

Some Interesting Notes about Access

The following brief notes are applicable to Access, Microsoft's database            management system.

Some Terms:

Table:

A collection of data about a particular unit. In relational database, this data is          presented in columns(attributes or fields) and rows (records)

Query:

Brings requested information together to satisfy a question. The resulting set of      rows is called a dynaset.


  Control:


 An object on a form or report which displays data from an attribute,                           results of a calculation, a graph, picture or other object.

     
 Form:

An object which can be used to enter, alter and view rows on a screen or                 in printed form.


 Report:

An object used to present information in a custom layout. Multi levels of                    totals are normally associated with a report.


 Macro:

A list of functions which will execute when called. Normally a group of                      regularly used functions.


 Module:

A collection of procedures which are built using the programming language.


 Object:

A unit e.g. table, form, report, control which can be selected and used as                  a unit. 

            Some Functions:


1. Opening a database

             Start Access.


  Choose Open Database from the File menu. 

             Select the required database from the File Name

             List box.

             Choose the OK button.


2. The Database Window.

Menu Bar - includes menus and commands used to create and use                         objects.


  Tool Bar - range of options for common operations and for obtaining help


  Object Buttons - provide direct access to every object in the database


3. Viewing Data and Closing a Database.

              In the database window, click the Table button.

              Double click the name of the table you wish to see.

             To return to the database Window, click it.

Note: Fields can be resized and rearranged as with a spreadsheet.                           Horizontal and vertical scrolling is also available.

To run a Query, click the Query button in the d/b Window, and double click  the Query required.

             To View data using a Form: Click the Form button  in the d/b window.

              Double click on the Form required.

             To display a Form in Datasheet view, click the Datasheet View button on                    

              the tool bar.

           4. Closing a Database.


   Switch to the Database window

              From the File menu, choose Close Database

            5. Creating a New Database


    Choose New Database from the File menu

               Enter your database name selected in the File Name box

If you are going to store the database in a  different directory, use the                      Directories list  to nominate your choice

If you wish to change drives, use the Drives list.  After completing the                      New Database dialog box, click OK

The next step is to set up the object (table) structure within your database. After this is  completed,  you will be able to create other objects  (Query, Form, Report).

           6. Create and Modify an Object

Create : Click the Object button indicating the type of object (table,                                             query, form, report..)

               Choose the New button.

               For modify, click the object you require, then click  the Design button      

               Follow the prompts


7. To Create a table

Start Access and open the appropriate database  The term ‘tables' will                                 appear in the database window

           Choose the New button ( i.e. New Table)

 
  Enter data as appropriate in the various columns, including Description

             Field name defines the field

             Data type defines the type of data for the field

             To move from box to box, press TAB

Some data types are default. To access the data types list, click the arrow    to open the list, or use the first two characters of the data type in the             appropriate field.   e.g. for a Currency datatype, type   'cu'.                


   Cue Cards.


   Use the Cue Cards from the Help menu to assist you with your tasks


  On Line Help.

             Click on the large Question Mark on the toolbar

  Choose Search and supply the first 3 (min) characters of the topic you                       

   require.

              Double click a keyword related to your unit

             The F1 key is also a good entry point to Help


Today’s Working Exercise

           You are going to create a small customer database using Access.


           The structure of the database is

           First name : character: 10 bytes 

           Last name  : character: 15 bytes

           Address : character : 30 bytes

           Customer Account Code : numeric : 6 bytes (must be > 500 and < 

             599999)

           Date of Birth : date (must be > system date)    [> date()]

           Invoice Number : numeric : 4 bytes

           Invoice Amount : money : profile $9999.99

           Invoice date : date

You will notice that there are some constraints placed over actual values of data which the table can accept. For instance the Customer Account codes must be in the range 501 to 599998. This is a property constraint and is entered in the ‘Validation Rule’ box. In this case the ‘Rule’ is >500 and <599999

Once you have created this structure, and indicated the primary key by                    highlighting the attribute and dragging the Key icon to it, populate it with some         representative data. For multiple keys, hold down the Shift Key while dragging.

Develop 10 records with varying Invoice dates and amounts.   

Now perform these tasks:

(1)  Find which customers have Invoice amounts in the range $20.00 to                         $500.00

List all customers - Last Name, Address, Account Code

These are probably commonly recurring outputs required from the database tables.

You should create queries and Name them (not query1 but Invoice Analysis ….)

There are some additional Access notes and exercise materials which you will find helpful on pages 41 and 42 of these notes.

Next tutorial session you will be using Oracle, which is a client-server relational database management system.

TUTORIAL  WORK   -   SESSION  9

The impact of management systems in your working environment is such that you will  need to have a good grasp of this topic to have some concepts of how you will need to operate in your business careers.

This tutorial we will be attaching to the Oracle Database and trying out some of the partly graphics based functions.

The following exercise based on the Oracle database will give you access to some of the political history of Australia - particularly Prime Ministers, Ministries and Deputy Prime Ministers since 1900.  The exercise will introduce you to SQL

If you followed the election held on October 9th 2004, and the result, you could insert 'new' data into your tables. There will probably be another one this year        which will also create ‘changes’. 

Oracle is available via Windows XP, and the terminal you use is a client of the Oracle Server. This server is actually an Alpha3 device known as Orac and is located at the Clayton Computer Centre.

You have an account on the server which is  made up of the letter S plus the  numbers of your Student I.D.   (e.g. S10135789).

Your password to this account is student and the service you will use (the database name) is CSE1720. 

To attach to the database you will need to log on to the Novell network, as normal. 

From the Program Bar  select (direct the mouse pointer to)   Development, then Oracle 9i, then to Oracle – OraHome92, then Application Development  and finally to SQL Worksheet. The SQL Worksheet will be made available.  This can be a frustrating experience but – persevere !

A Entry window should appear on the screen. Note that advancement through Oracle dialog boxes is invariably by using the TAB key.  The normal use of the Enter key will cause an error.

Enter your student number and (TAB), your password and (TAB)  and the service  CSE1720  You may need the extended form which is CSE1720.cc.monash.edu.au.     

You should be presented with a split worksheet at the SQL level. The top half is for command entry results, the lower half for results (and a few other things).

There are a number of tables in the schema which relate to some part of Australian political history.

The table names are pm_minister,  ministry, pm_rec, pm_marriage,

and deputy_pm. The schema details are attached to this tutorial sheet.

Convert these tables to your own tablespace by using the command

Create table pm_minister as select * from simpson.pm_minister;         for the pm_minister table, and similarly for the others. Make sure you include the ;
For each table inspect the contents with   select * from <table_name>;
When they are all present,  run these queries:

Select the prime ministers whose recreations are riding, tennis or walking

  [ select pm_name where recreation in ('riding','tennis','walking');   ]

Which prime minister and spouse had no children. What year were they married ?

 [ which table contains this information ?  A script such as select pm_name, spouse_name from <table> where nr_children = 0; could be a guide ]

3..Which prime ministers were appointed after the year 1923. What Ministry or Ministries did they lead ?

[ locate the table which contains this data, and then  nominate the attributes required - in this example the pm_name and the ministry - and of course restricted by the year 1923 ]

4. Which prime ministers represented Victoria ?    What parties did they represent ?

5. What is the average death_age of the Prime Minister group ?

6. Which Prime Ministers died (a) below this age and (b) above this age ?

7. What were the names of the Prime Ministers who served in the Liberal and Labor parties. What years were they appointed ?

8. The data in the pm_minister table is not up to date. See if you can fix this by inserting this data :

  Hawke R J L was the Prime Minister for ministry number 48, which commenced      on 11-3-83, and also Ministry 49 which commenced on 7-12-84. He was also the     Prime Minister for Ministry number 50, which commenced on  11-7-1987.He led    the Labor Party.

The format of an insert is: insert into <tablename> values ( for example 'Hawke        R  J   L',  48 …..);

  Non numeric data needs to be enclosed in '      '.     

  Dates are entered using the form  ‘24-Nov-2001’.

  Numbers are clear  e.g.  34.

TUTORIAL  WORK   -   SESSION 10

READING: Parker and Morley;  Pages 298 to 335. There is a great deal of             Information here, and you probably will not have sufficient time to  study it at depth.


The diagrams relate to America, but are valid irrespective of the country.

The Summary and Exercises on pages 336 to 340 will assist you in your reading.

Computing gained a boost to its acceptance in the business world because of the linking of computing and communications capabilities.

In most cases, users are unaware (until an account is presented) of the actual source of computing. Your computing at Monash could be on-site or it could be provided by equipment located at Clayton, Frankston or indeed anywhere where a computing source can provide the resources required.

Reading the chapter will give you some idea of the hardware and software facilities, which together give users access to a wide range of data and of processing capability.

You will probably need this laboratory time to complete your Oracle excursion and your database assignment.

TUTORIAL  WORK   -   Additional  Support

Reading : Parker and Morley : Pages 252 to 265 provide information about MS Word

You will be required, both during your course and in the business environment, to prepare reports and other formally prepared materials. Sometimes this will be straightforward text, but there will also be the need to provide material containing columnar data, graphs, and also graphics based presentations. As computing reaches more into the people 'environment', there will be the need to provide dynamic information via user terminals.

There is a test data file located on the web page. The file name is                    PERSAMPL.DOC. Load this to your terminal and use it as the sample. Remember that you can WRITE only to A: or  B:

Microsoft Word   -    WordProcessor

Microsoft Word is one of a variety of packages which allows for the presentation     and management of information. Although you will have only this session to            introduce yourselves to the software, you will at least gain some lasting                   impressions. Word has a Windows user interface, and this is indicative of the         development of user access to information and indeed computing.

Access to Microsoft Word

After logging on to the server, wait for Windows to load and then click on the           Microsoft Word icon in the programs list.

Copy the file 'persampl.doc' from the website to one of your diskettes. This is          actually a WordPerfect document file, but it can be read by Word.

Set the font to Roman New, size to 12 point, and proceed to use the bold feature,     italics, the word speller and font changes to emphasise an item. (for example         you might bold the sender's name).  Use the ‘Grammar’ facility (Tools menu) and    assess if it helps . Also examine the statistics table.

 Use the icon to initiate indentation of the first line of a paragraph and also see if         

 you can insert today's date in Day Month and Year format at the sender's area.

    Redirect the output to your diskette but use another file name.  

   If you have time, investigate the possibility of importing your Excel graph into 

   the area of your document following the sender's name.

   Investigate the placement of one of the standard Word icons into your                     

  documents.

    Suggested reading: Parker and Morley : Pages 487 and 489

By reading through this module, you will gain an understanding of Expert                 systems, Robotics and Virtual Reality - their fundamentals, why and how these       fields of study have developed, and more importantly, the impact of these trends    in business and your environment. 

We are all interested in what is likely to happen in the next year, 2 years or even     longer. Sometimes we are correct, but technology has the reputation of 'being         different'.

This material will give you some insight to the future of the advancements in             technology and of course our own development. 

Computing gained a boost to its acceptance in the business world because of the linking of computing and communications capabilities.

In most cases, users are unaware (until an account is presented) of the actual source of computing. Your computing at Monash could be on-site or it could be      provided by equipment located at Clayton, Frankston or indeed anywhere where a computing source can provide the resources required.

Reading the chapter will give you some idea of the hardware and software facilities, which together give users access to a wide range of data and of          processing capability.

.

SOME ADDITIONAL FEATURES IN EXCEL WORKSHEETS:

  1. Data generation

  2. Vertical and Horizontal Lookup

  3. Frequency Distribution

 1. Data Generation 

This feature allows a user to enter a series into a worksheet. There are two methods:

    (1) Use the data, series functions

    (2) Use the Autofill - there are a series of 'special' terms in Excel from which a series can be developed. Months (Jan, Feb ...) and Qtr1 ....allow for a series to be developed.

 Enter a month, say Jan into a cell and position the cursor at the lower right corner (the  fill  handle). Drag the box to extend the series.

 For numeric series, using autofill, there must be at least two values (which gives the difference) before the drag feature can be used.

 2. Vertical and Horizontal Lookup

     The Excel function is:

       VLOOKUP(lookup_value,table_array,col_index_number)

What it means is that the leftmost column of an array (read range) in 'table_array' is searched for a value nominated in the lookup_value column. A value is returned from  the col_index_number array (generally a single column array)

Try this exercise:  Develop a range using the data, series or the autofill. Develop an array of groupings of say 5.  Develop column offset values of say a,b,c,d,           corresponding to the table array groupings.

If you develop the formula for the first element and then intend to copy it, make sure you use absolute addressing.

In order to test for errors, you could have an additional entry of 160 in the range      with a  return of ERROR !  These entries are Offset by 1 from the selection criteria.

In the column adjacent to the data cell (start with the lowest value) enter the formula

=VLOOKUP(<data cell address>,<Table Range>,2)

You should have a formula something like =VLOOKUP(A6,E7:F8,2).  After execution you should have a return of a value adjacent to the value 15.  

Copy the formula to accommodate the other values in the cell range and WATCH FOR THE ABSOLUTE ADDRESSES required.

That should be sufficient to get you going. I leave it to your imagination to appreciate the use of the function and also to work out how to use the =HLOOKUP. ( A hint - the H stands for "Horizontal" )

 3. Frequency Distribution

This is another feature associated with numeric analyses and provides the user with the opportunity to determine the frequency of occurrence of numeric values within groups - for example how many salaries in a table are in the range $25,000 to $40,000.

The function works on data in 'arrays', and requires that the range over which the data occurs and the 'bin' of values into which the range is to be analysed is nominated in the formula.


The base formula is

     =frequency(data range,bin range)

and must be located in a cell range equivalent to at least the bin range + 1. The formula is executed by using the standard array initiator                     SHIFT+CONTROL+ENTER.

Try the following exercise.   Use the DATA SERIES to create a vertical table of say 25 entries starting at 10 and having an increment of 15.

Set up a smaller table with the parameters 20,45,70,100,and 150 and arrange these vertically. (This is the BIN range). 

Now use the FREQUENCY function to nominate the data range and the bin range. Your result should be count of the occurrences of the values specified and the result area should have as many cells as the bin range + 1.

Excel Exercises:

These notes will give you an opportunity to develop or to revise your skills using Excel. They are not exhaustive, and you will need to access the on-line help. 

These exercises are intended to give you some opportunity to create a small spreadsheet and to use some of the ‘normal’ features of the software package.

They are probably similar to the functions you will use regularly.

Exercise 1

Open a new spreadsheet and in Row 3 of Column D enter your name.

                                                 in Row 4 of Column D enter your student I/D    

                                                 in Row 5 of Column D enter the unit code

That doesn’t look very attractive as some of the data is either hidden or 

overruns a column.

Widen the column so that all of the entries are clear. (Use the cursor to drag 

the column boundary in the black top area of the column and watch the width increase/decrease).

Improve the appearance of the range by Inserting in Column C the entries Name, Student I/D and Unit code. This will also need widening.  The appearance will be improved by bolding the entries in Column C.   Select the Format option from the toolbar and use the Font option to produce the required result.  While you have this option, move to Alignment and make all of the variables (Name etc) right justified.   

Again while you’re there, highlight the variable range and select Font from the options.  Change to Arial, Bold, Italics, size 16.   That probably looks a lot better.

Use the View menu and select the Formatting panel. Use this panel to colour the area of the variables.  You can experiment with the colour palette, but choose pastel colours rather than the strong colours.

Us the Font Colour to colour the variable names (Name. etc).  Use a contrasting colour for this to provide an eyecatching pattern.

When you’ve selected a suitable pattern return to the hard work of setting up a range of numbers by entering 7,12,17 in adjacent cells (it’s best if you use the vertical column method).  Highlight this and then drag the R.H. corner down the sheet. You should get an automatic list of progressive numbers with a difference of (in this case) 5.  Try another series and select your own range.

Now, in a clear cell range (which you can colour after) enter the text   Sum,  Average,  Minimum,  Maximum,  Standard Deviation. (again in vertical column       format). 

What you are going to do is to use the features of the spreadsheet special functions to calculate from the series you have just produced.

So, in the cell adjacent to the Sum, enter the formula =sum(         To complete this, position the cursor at the top (or bottom) of the required range and move the cursor to the other extremity. When you have done this, press Enter  and the expected results should appear. You will have an entry like  =sum(A1:A10)

Do this for the other functions. The average function is  =average(   ), minimum is =min(  ), maximum is =max(     )  and the standard deviation  is  =stdev(   ).

If you have made an error with the function call, use the Help to provide assistance. The Esc key will also help to reverse or cancel calls.

When you have done all this, save your spreadsheet TO YOUR DISKETTE and call it Lesson1.      The form will be     saveas  a: lesson1.  While the save panel is open, click the option which will provide a backup facility.

There is a possibility that your spelling needs checking. So, use the SpellChecker option (the ABC button on the tool bar) and make sure that everything is as you expect.  Then you will need to save the spreadsheet again.

Incidentally, I will be deducting marks from your assignment for misspelt words, so using the spell check feature is worthwhile.  And of course in your work environment, Managers won’t be too impressed if your work contains errors - and you won’t be either if your subordinates present work which is not accurate.

Now that you’ve use the spell checker, save the file again, using the same name. 

Close Excel.  Because you’ve forgotten to include the date on the spreadsheet,  open it again and retrieve the spreadsheet you’ve just made. (Use the ‘all files’ option and drive A: )

See if you can locate the Date function and insert today’s date on your spreadsheet. =now()  will be helpful.  Watch this as it will change as the date changes. If you want a ‘permanent’ date you will need to use a text entry or use the help to find out how to enter non changing dates.

Try a few exercises of your own making, and use the Help to further research the Functions which Excel (and other spreadsheet software) offers.. (Help Functions etc).

The =SUM  function allows you to use the normal arithmetic operators +  -  / and *  (add, subtract, divide and multiply). Create (simple) examples to gain some competence in their form and use.

The spreadsheet assignment calls for development examples of certain built in functions.  You should spend some time in locating and using the ‘help’ function.

Excel Exercise 2

These should supplement the first sheet, which were simple calculations, editing and formatting.

1. Highlight a contiguous range of cells and name the range. Use the Help to use the shortcut method .

2. Use the Insert, Name, Define to verify that the range exists with the range co-ordinates you allocated.  

3. Using the same function, attempt to create another range - what difficulties did you strike ?

4. Enter a value in a cell, name it.   Enter another value and name it also. Then use the =sum function to (a) add the two cells, using the names

                                  (b) multiply the cells

                                  (c) add the product of the cells to the sum of the cells

Excel Exercise  3

This tutorial will give you some experience in developing formulae using variable cell addresses, the ‘ripple’ effect of developing one formula and then copying it across a range of cells, and the use of the Auditing features to trace the precedents and dependents of your embedded formulae. (This is a very effective way of finding and clearing errors).   You will also convert the data into a graphical representation.

The spreadsheet file is available from the web page and has a file name of student1.xls.

Copy it to disk and then load it and you should see a part prepared worksheet for the Coffee Shop (not Merlin’s).

Examine the results given, and use these as a base for your formula development.

Complete the details for the Expresso Coffee sales for July to December, 1999. (which was before the GST – how could the spreadsheet be altered to include any GST charge ?)

Develop the total sales (value) and also the total number of cups of coffee sold (and highlight this).

Find (a) the average cost of a cup of coffee over this period, and also the average profit per cup over the period. Highlight these values as well.

Find the minimum and maximum sales of Expresso Coffee from January to June.

Use the Tools menu to locate the Auditing toolbar, and locate the Trace Precedents icon.   Highlight ALL of your calculate results (point) and you will see that blue trace lines appear on your screen to indicate which cells are involved in the calculations.

Scan the traces, and see if you agree that the cells involved are in fact the ones which should be used in the calculations. When you are satisfied, set the Precedents OFF, and the screen will revert to the normal appearance of the spreadsheet.

Now graph, or Chart as Microsoft calls them,  the sales of Expresso coffee for the six months - firstly choose a graph form which will adequately illustrate this requirement (probably a bar chart).

Select Insert, then Chart from the toolbar, and use the cross hair icon to reserve a space on the spreadsheet for the chart. Use the chart wizard to select the chart type, the LEGEND (which names the chart) and name the X and Y axes (watch the dialog boxes carefully).  If you make too many mistakes, delete the chart and start again.

Now create a pie chart which give the contribution of each month’s sales to the total sales for the Cappuccino coffee sales, and likewise label this chart.

Finally, double click on the tab ‘sheet1’ on the status bar (lower left hand of the worksheet) and rename it   coffee.

Save the spreadsheet and log out, if you have no other work to do.

By the way, what is the difference between a spreadsheet and a worksheet ?

Excel Exercise 4

In this exercise you will be developing some of the extension features of the SUM function.  You will need to start a new spreadsheet in your worksheet and you should select a blank tab (bottom of screen) and rename it Sum Examples (double click the tab, and key in the name).

The exercise is a simulation of a chequebook register. 

Cell C7 will contain today’s date ( use =today() function)

Cell D7 will contain the  money value of the current deposit transaction. 

Cell E7 will be used to hold any withdrawal amount.

Cell F6 will contain the previous balance, and the initial setting is 0

You haven’t finished setting up yet, as cell D5 will contain a person’s first name, and cell E5 should contain the person’s last (or family) name. 

You should place meaningful names on all of these cells – the cell above your chosen value is a good place, and you can use cell colour-fill to highlight the different ‘headings’.  Don’t forget to format the money cells for Currency, 2 decimals, and position the name cells to the right of the cells.

Place some real values in all of the cells mentioned.

And as a quick check :

C7 is today’s date

D7 is the current transaction deposit amount

E7 is the withdrawal transaction amount

F6 contains the previous balance, and this must be set to 0 initially

D5 is a person’s  first name

E5 contains a person’s family (or last) name 

Now off to work we go :

In cell D7 ENTER 100 (and if you have used the Format ,Currency option, this should appear as $100.00).

Now enter the formula =sum(F6,D7, -37) into F7. This is the first balance.

Enter a value into either D8 or E8 or both, and copy the formula from cell F7 to F8. This will give the ongoing balance – and don’t forget to date the transaction. 

Names Manipulation

In cell G6 (or your choice of cell) enter the formula =D5&” ”$E5

In cell H6 (or your choice of cell) enter the formula =E5&” , “D5

Value Manipulation

In an unused cell, (say H5), enter the value 60. Then the formula =H5*(1+5%) will increase the value in cell H5 by 5%.

Alternatively, if the percentage uplift mount is stored in a cell (say H6 as 5%) then the uplift calculation would be =H5*(1 + $H$6) 

Count of Occurrences of Alphabetic Content

Assume that in a column, say J, there are 45 names (J2 to J46). And assume that some of the names (as in a telephone directory, are the same).  How many are there ?  Use the help, but read the next page first.

If the formula =countif(J2:J46,”AaAaAa” ) is in cell K1, then the resulting value will be the number of names with the construction AaAaAs in the list  

Excel Exercise  5

CSE1720 Extended Excel Exercise

This exercise you are going to use some of the random number generation functions to construct a line chart and a scatter chart. (Microsoft call them charts, you may know them as graphs). You will also perform some editing and formatting on these charts.

The random number generation will be based on the form rand()*(b-a)+a and rand()*a.   If you are unsure what these functions mean, use the help.

In cell A1 of a spreadsheet, enter Jan.  Pull the value down to cell A12.  You should have the months January to December.

In cell B1, enter the formula rand()*(40-1)+2. Copy this to cells B2 to B12.

In cell C1, enter rand()*50. Copy this to cells C2 to C12.

You should now have generated 2 sets of random numbers.

You are going to use these as the basis of some charts after you format them to integer form – Use   Format, cells,  no decimals.

Exercise 1.   Use the 3 column sets to create a scatter chart (with line profile).  

On the menu bar select Insert,  Chart, and then select from the chart types the scatter chart and the form of scatter chart.  From then on follow the Wizard prompts. The chart is to be part of the current worksheet.

 Notice that the ‘months’ do not appear. Why is this ? In order to answer this you will need to understand just what a scatter graph shows.

You should have 2 charts and you might need to scale these.  If you do, select the required Axis, then use Format, Axis and then alter the values given in the boxes until you have a clear and well defined chart.  

In replying to the various prompts (Step 3), enter a chart legend (your choice), then provide a name for the X-axis and a name for the Y-axis.

The chart is to be part of the current sheet. There is a prompt which offers this option.

You should have a chart which is named, shows the X and Y axis names, and has two coloured lines on it.

There should also be a small box to the right of the chart, probably with the legends Series 1 and Series 2.  The colours of these should correspond to  the body charts.  The original sets of values were not named, and Excel provides default names.  

You can alter these default names by selecting the box, then using the menu functions  Chart, Source Data and Series. At this point you will be able to provide a name in the dialogue box provided. When you use the Enter key, the names you have entered will become the names of the charts.

Save the worksheet using the ‘Save With Backup’ option. This will leave the current contents available for the next chart, which will be a line chart. 

Exercise 2. Development of a line chart.

Follow the same procedure as for the scatter chart, but make suitable alterations to reflect the different aspects. (axis names ….)

Exercise 3. Examination of the two charts

Position the two charts one under the other and examine differences which you notice.

If you feel adventurous, you can use the Format functions to introduce colour text and backgrounds as well as highlighting data or results. You can also alter the colour of the chart lines.

Close the worksheet.

Finally, use Windows Explorer to examine the folder you selected to hold the worksheet, and look for the worksheet name with a .xls extent, and the worksheet name with a .bak extent.

If you create a chart on a separate sheet (part of the Wizard functions), then the chart will be saved with an .xlc extent.

Excel Exercise 6

One of the requirements of Management is to have results and reports which are accurate and representative.  This is dependent on base data being present, representative and accurate. There are a number of techniques which are used to ensure this, one of them being data typing, another being ‘self checking algorithms’, another being the use of inclusive or exclusive range values (both numeric and  non-numeric) and there are a number of software functions which are used as well.  You are going to use one of these in this short exercise.

Excel worksheet Tools menu has a number of ‘aids’ to accuracy. You will have used by now the Auditing menus with the Precedents sub menu, and this will enable correlated errors to be traced and corrected.

Another simple, but very effective tool, is the Validation function in the Data menu.

To try this out and get some feel of what can be done, select some blank rows in a column of a worksheet (highlight) and pull down the Validation option from the Data menu.
The first pull down box is Settings – so select a setting (say, decimal)

This leads on to actual data settings – Minimum and maximum, or other selections.  Experiment with one of these

The second pull down box is Input Message. There is provision for a Title, and an Input message.

The third option is Error Alert – you can elect to stop entry, raise a Warning message, or an Information message.  Experiment with the ‘Warning’ style, with a Title and Error Message.

Now enter some data and see what happens.

If you have used the Warning feature, you can pull down the Auditing toolbar from Tools and by clicking on ‘Show Auditing Toolbar’ and clicking on the 2nd last icon, you will see that error data in your set will be circled.  This of course cannot happen if you have selected Stop.  

Now that you know about these functions, you will be expected to embed them in your assignment where appropriate.
An Access Exercise

The preliminary exercise on Page 25 introduced you to creating a table with some constraints (conditions which control values in the table(s) or which control the processing of  values in the tables(s))  and you developed a query – which gave a limited set of output, either with or without calculations.

The more common use of relational databases is to associate data in many tables in a database using a number of techniques,  the referential Foreign/Primary key being at the top of the list.

In this exercise, you will create and populate 3 tables, with constraints, and use the dialog boxes and prompts to allow you to select required information as the output of a query.

The three tables are

Employee(Employee Number, Date Hired, Last Name, First Name, Date of Birth, Street/Road Address and Suburb, PostCode, Gender

Position(Employee Number, Store Name, Department, Job Title

Payrate(Employee Number, Hourly Rate)

From this you can deduce that you are setting up a small database about people who are employed in a Store(for example Myer), where there are a number of Departments (Books, Shoes, Perfumes, Clothing …)

You  might examine the Primary-Foreign keys in the above table schemas. What are they ? Are they practical ? Can they be constrained ?  As you spend some time on this exercise you will build up the conditions which suit the database profile, or more importantly, suit the Business case.

In creating the tables, you will need to allocate a datatype and size to each attribute. (50 bytes for a name is too many bytes)

When selecting datatypes, be explicit. For instance - an Employee Number. Is that a real arithmetic type number or is it a general term meaning Identification ? Is it a number such as 34895,  or P261 ?    It’s your choice. Whatever you select, the datatype must give you the degree of conformity you expect. So,  be precise.

In creating the structure, you must work with both the  Field Names and Datatypes AND the properties (in the lower box) which you will assign to the fields again based on your understanding of the business case. Use the pull down options boxes.

In the case of the table ‘Employee’ these properties could be assigned to the

 ‘Employee Number’ ;

Date Type : number


Field Size :  single




Decimal places : 0

Validation Rule : > 100

Required  : yes

This means that the Employee number set must be ‘single’ length (use the help to follow this up), there are NO decimal places allowed in the real data values, the number set must not contain any value less than 101, and the Employee Number is Required – there must be a value in every row. 

Each attribute will have its own set of ‘properties’

Every Primary Key must be set to Required and must be unique (not duplicated). 

The Primary Key is assigned by highlighting the appropriate attribute and then clicking the ‘key’ symbol. For a multiple key, hold down the Shift key.

When you have created the all of the table structures, you will need to populate them. This needs care as the data in the various tables must be able to be related through the Primary-Foreign key values..Create 5 rows in each table.

Now, onto the development of a query  (or two):

Use Tools, Relationships to create the association between your 3 tables. This is done by associating the Primary Key in one table with the Foreign key in the joining table. Drag the pointer to the selected key.

Return to the main menu and select ‘Queries’. This should bring up a dialog panel with ‘New’ (meaning a new query is about to be developed) and you will also see the terms ‘open’ and ‘design’ – more about that later.

Select the ‘new’ option and from the dialog box which appears, select Design View.

Select the tables which will take part in your query, and ADD them. When you have finished selecting the tables, close the ‘Show table’ dialog box and then start selecting the attributes names into the field boxes on the query properties dialog box. You will probably select :

Employee Number, Last Name, First Name, Date Hired, Store, Department, Hourly rate – in that order.

You will need to select the appropriate attributes from the tables where the data exists.  Drag the attribute name to the ‘Field’ column of the panel.  Take your time and when you have selected all of the attributes, click on the top left hand button on the Query development box and call the query ‘Employee Query’.

You should now have a query named ‘Employee Query’. Run it by highlighting  

      ‘Open’  Are the results what you expected ?

Now create another query which will allow the analysis of data with the criteria that the ‘Date Hired’ is after the 12th December, 1988.     To develop this,  follow the procedure as above, select only those attributes which are relevant to the query, and  in the ‘Date Hired’ field, use the criteria setting to insert 12/12/1988.   Close the query development, call the query ‘Date Analysis’ and run the query.  This date can be altered in the Design mode for any other data based query – but be careful. When the query is run it will use the current embedded date, so the user must be aware what the date set is – if not, then there could be confusion or error in using the query output.

Finally, to round off this exercise, develop a query to show the names of those people who work in a nominated store (your choice).  Run the query.   Amend the query to show more than one store by amending the criteria to include another store using the Or function:  for example if your selected store was Chadstone and you wanted to include another store (Highpoint), then the criteria would initially look like ‘Chadstone’ or ‘Highpoint’  NOT Chadstone AND Highpoint as a person can work only in one store at any one time. 

